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1.1 What is GEOPAK Drainage? 

GEOPAK Drainage is a comprehensive system for designing and analyzing storm drain systems, 
which can leverage many roadway design features to create a seamless information exchange to 
the drainage design process.  A GEOPAK Drainage project may contain multiple drainage 
networks; each comprised of any number of topologically connected drainage areas, inlets, pipes 
and ditches.  The GEOPAK Drainage workflow closely mirrors conventional design processes 
allowing for the design of the surface collection system (i.e. drainage areas, inlets) then the 
design of the subsequent conveyance system. 
 
GEOPAK Drainage is extremely flexible, in that the hydraulics designer can create and 
manipulate elements of the system, while simultaneously seeing the effects.  Interactive dialogs 
and design visualization make the process easy to learn and efficiently produce results.  
Manipulations and redesign are accomplished quickly and easily, whether it's moving a single 
inlet or developing an entire network.  At any time during the process, customized reports can be 
generated to provide hard copy outputs.  
 
Roadway alignments, vertical profile gradelines, and digital terrain models created as part of the 
design process may be used throughout GEOPAK Drainage to provide pertinent information to 
drainage design.  All drainage components feature interactive graphical placement tools for easy 
spatial definition of the drainage system. Visualization tools in GEOPAK Drainage for networks, 
drainage components, and computations all but eliminate the tedium of thumbing through pages 
of computer output to evaluate whether the system is functioning adequately.  The visualization 
allows for immediate evaluation of the drainage system. 
 
GEOPAK Drainage hydrologic and hydraulic capabilities include runoff computations, inlet 
design and analysis, and pipe and ditch design and analysis.  All computations follow 
recommended methodologies in the FHWA publication “Drainage of Highway Pavements” as 
well as the procedures in the AASHTO Model Drainage Manual. 
 
Runoff computations are performed using either the Rational or SCS method where rainfall 
parameters may be specified with common intensity equations, hydrographs, or by tabular 
intensity-duration data.  Drainage area delineation tools allow easy creation of contributing areas 
and the graphical assignment of these to drainage features.  The extremely tedious task of 
compiling different subareas and runoff coefficients is practically eliminated by GEOPAK 
Drainage’s graphical shape tool, allowing easy creation of drainage areas and land use 
boundaries.  Once the boundaries are defined, the runoff coefficient and associated hydrologic 
parameters are computed automatically by delineating the land use zones inside of the drainage 
area.  Any subsequent modifications to the boundaries will update the runoff coefficient via a 
single mouse click. 
 

For GEOPAK Drainage support, please contact the CADD Support Center. 
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1.2 Objectives 

• Understand the components of GEOPAK Drainage 
• Understand the contents of the Drainage Library 
• Learn how to set Project Preferences 
 
 
 

1.3 Project Workflow 
 
The GEOPAK Drainage workflow mirrors the conventional design process beginning with the 
design of the surface collection system (inlets, drainage areas) followed by the design of the 
conveyance system (subsurface pipes, channels). 
 
Roadway alignments, vertical profile gradelines and digital terrain models may be used 
throughout GEOPAK Drainage to provide pertinent information to the drainage design.  All 
drainage components feature interactive graphical placement tools for easy definition of the 
drainage system. 
Each of these components (inlets, areas, pipes, and other objects) are composed of two basic 
types of information: 
 

Spatial information describing its location, shape and connectivity. 
 

Hydraulic and hydrologic information describing its properties, conventions and other 
associated attributes. 
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1.4 Components 
GEOPAK Drainage organizes the components of a drainage system according to their spatial 
characteristics.  Spatial information is stored as Nodes, Links and Networks. 
 

Nodes:    A node (inlets, manholes, etc.) is a point with a user-defined location.  The 
location may be in Cartesian coordinates (x,y) or in curvilinear coordinates (station, offset).  
Nodes are used to model: 
 

• Inlets (curb inlets, grate inlets, slotted drains) 
• Junctions (manholes, grade breaks, bends) 
• Outlets 
• Others (user-defined) 

 
Links:   A Link represents a linear feature depicting a path connecting two nodes, traversing 
upstream to downstream.  The path may be straight line or curvilinear (along a graphic 
element).  Links are used to represent: 
 

• Pipes (over +1,000 default pipes) 
• Ditches (any shape – including automatic design capabilities) 
• Channels (cross section based utilizing TIN files) 

 
Networks:   A network is a series of interconnected nodes and links that form a system 
through which water can flow to a single outlet node. A single project accommodates any 
number of Networks of varying types. 
 

Other associated components in GEOPAK Drainage include: 
 
Areas:   A drainage area can be represented by a closed boundary or simply keyed-in (acres 
or hectares). All flows from a single drainage area are tributary to a single Node.  Thus, 
there is a one to one correspondence between a node and an area.  Therefore areas and nodes 
share the same name (ID). A drainage area may contain multiple subareas representing 
homogeneous features such as soil types and land uses (“C” values), thereby allowing 
composite "C" value calculations. 
 
Profiles (Hydraulic):    A profile represents a path connecting any two nodes in a Network. 
Profiles provide the visualization of profiles between any two nodes in a drainage network. 
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1.5 Invoking GEOPAK Drainage 
GEOPAK Drainage is part of the GEOPAK suite of civil tools and needs to run within the 
MicroStation environment.  Follow the steps listed to access GEOPAK Drainage. 

 
1. Launch ProjectWise Explorer and navigate to the following location: 

 
District CADD\ Design\Cole#\J5EX501\Data 

 
2. Find the following file and open it with MicroStation: 

 
plan_J5EX501.dgn 

 
3. From the Applications pull-down menu choose GEOPAK > Drainage 

 

 
 
Once activated, a separate menu for Drainage will show up next to the Applications menu.  All 
items in Drainage can be accessed through this main Drainage pull-down menu. You can also 
use the Drainage Tool Box by choosing the Main option under the Tool Boxes menu or use the 
Drainage menu bar which is displayed whenever Drainage is active: 
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Every time GEOPAK Drainage is activated it opens as an untitled project and is set to use the 
Bentley default preferences.  In order to have the correct default MoDOT preferences you will 
want to change this by using one of the procedures outlined below. 
 

 

 
Once you have done either of these processes the banner for your Drainage menu bar and the 
MicroStation window should display your drainage project name. 
 
 

Beginning a New Drainage Project -  When you are starting a new project and have 
activated GEOPAK Drainage for the first time on that project: 

1. Click the Project pull-down menu on the Drainage menu bar and select the Preferences 
option 

2. Click the File pull-down menu on the Preferences dialog box and select the Open 
option 
- The Open Drainage Preferences dialog should pop up and the folder location 

should be set to your project data folder 
3. Select MoDOT_Drainage.dpf from the list of available files and click the Open button 

in the lower right corner of the Open Drainage Preferences dialog box 
- The MoDOT_Drainage.dpf file simply changes all of the variables in the Drainage 

Preferences to reflect the suggested MoDOT settings 
4. Click the OK button on the Preferences dialog box to apply the new preference 

settings to your drainage project 
- You will be prompted to save your drainage project at this point 
- This must be done before you can change preference settings  

5. Choose the No Wizard option and click OK 
6. In the Document section of the Save Drainage File dialog box change the Name and 

the File Name to the name you would like to use for your drainage project file 
- The system automatically fills in these fields using the name of the DGN file you 

are currently working in and giving it a GDF extension 
- The name you use much match in both the Name and the File Name fields 
- It is not necessary to change the Description but it can be helpful later on if the 

project is large and might require the use of more than one GDF file  
7. Click the Save button on the Save Drainage File dialog box 
8. Click the Yes button when the system prompts you to store the preference changes 
9. Now you can open the Preferences again and make any changes necessary for your 

project situation then click OK to apply to your GDF 

Opening an Existing Drainage Project -  The GDF file stores the preferences that were 
assigned at the time the project was last saved and so if you have an existing project then you 
simply need to open your GDF file to restore your preferences and settings: 

1. Click the Project pull-down menu on the Drainage menu bar and select the Open 
option 

2. Select your existing GDF file from the list and click the Open button in the lower right 
corner of the Open Drainage File dialog box 
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4. Follow the instructions provided on the previous page for beginning a new 

drainage project. 
- For step 4 we will make changes to the Preferences as we progress through 

the following pages and review the different options 
- When you reach step 6 in the instructions use the following name for your 

file: 
 

drainage_J5EX501.gdf 
 
 
 
 

 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

A little information about the GEOPAK Drainage File (GDF): 
 
The GEOPAK Drainage File or GDF stores the drainage project data in much the same way 
that the GPK file stores the data for GEOPAK Road.   
 
A single GDF file can be used to store data for multiple networks (individual drainage 
systems).  However, the GDF file format can become corrupted if pushed too far and it is 
recommended that if networks are large/complex that each network should be stored in a 
separate GDF file. 
 
The GDF file can be corrupted if more than one user accesses it at one time, so the GDF file 
should be stored in ProjectWise and not on the T: drive.  
 
As mentioned in the instructions given for opening an existing drainage project, the GDF file 
stores the preferences that are assigned when the project is saved and those preference settings 
will be restored when the GDF file is opened for use. 
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1.6 Review Project Preferences 
The Project Preferences control the graphic and computational options of the drainage system. 
Each category of options contains variables that are set to MoDOT suggested standard settings.  
These settings can be manipulated by the user if needed during the design process. 
 

1. Click the Project drop-down menu and select Preferences. 
 
 

 
 

Units 
This option defines what system of measure the project will use when performing calculations 
and generating output.  It also provides the user with information about what units of measure 
are being used for specific input and output fields. 

 
English   

 

 
 

 
 

For each of the Options on the Preferences dialog box we will be changing the 
settings to fit our project needs.  The values we will be using are highlighted.  
Please make sure your preferences are set up in a similar manner. 
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Project Components 

 
 

Drainage Library File (DLB):  T:\Gpk_std\Drainage\dote.dlb 
 
GPK Job Number: job###.gpk  (GPK file for the job you are currently working on) 

 
Drainage Cell Library:  T:\Gpk_std\Drainage\drainage.cel 
 
Criteria Directory:  MoDOT does not use criteria for Drainage. 
 
DDB:  MoDOT does not link Drainage to the GEOPAK D&C manager database at this time. 
 
Water and Sewer Project:  MoDOT does not use Water and Sewer projects. 
 
 
 
 

When setting up the preferences for the first time on a Drainage project the user needs 
to set the path to the GPK:   

1. Click the User Preferences button to the right of the magnifying glass 
2. Click COGO Preferences button on the User Preferences dialog box 
3. Set Job (GPK) Directory to the correct T: drive data folder for the current job  
4. Click OK for the COGO Preferences and again for the User Preferences 
5. Once this path is established the user can click the magnifying glass button and 

select the correct GPK file from the list. 
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Supereleveation Shapes File:  This field can be pointed to the superelevation shapes file (DGN) 
allowing Drainage to read elevations, cross slopes, and grades for jobs with roadway sections 
that are superelevated 
The superelevation shapes file must also be referenced into the DGN file you are using for your 
drainage project 
 
Site Project:  This field can be pointed to the GEOPAK Site File (GSF) for a Site project 
allowing Drainage to use data from a Site model or object 
 
Original Ground:  MoDOT does not typically assign an original ground surface 
 
Design Surface:  User can assign a final design (proposed) TIN file that will allow Drainage to 
read and use surface elevations when working with components 
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Rainfall Parameters  
The rainfall Parameters option is used to select the intensity equation to be utilized on the final 
project.  Both the Rational Method and the SCS Methods are available. 
 
Section 749.4 of the EPG states that the Rational Method should be used on all watersheds less 
than 200 acres in size.  For further guidance please refer to Category 749 of the EPG.  
 
Select District 5 as the Rainfall Source under the Rational Method.   
 

 
 
Rational Method Rainfall Source: The Rainfall Data Source for computing intensities and 
discharges, which is stored within the Drainage Library File, therefore it may only be selected 
here.   
 
SCS Method: Rainfall Source is the data source for computing discharges, which is stored 
within the Drainage Library File - therefore, it may only be selected here.  The Antecedent 
Moisture Condition I is the lowest runoff potential (dry soil), while Antecedent Moisture 
Condition II is the average condition, and Antecedent Moisture Condition III is the highest 
runoff potential (saturated soil).  
  
Hydrograph Time Interval: Specified in terms of minutes. 
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Land Use Options 
The Land Use dialog establishes the land use options used to delineate sub-areas and runoff 
coefficients for the current project.  When selected from the Options list, the dialog depicted 
above is displayed. 
 

 
 
Single Land Use Item The land use source from the Drainage Library containing the runoff 
coefficients and symbology for land use delineation may be selected from the list box. 
 
Select Single Land Use Item and make sure MoDot is set in the list box 

- This will allow you to choose from all the predefined land use types and their 
corresponding C values contained in the MoDOT library when assigning land uses. 

 
Multiple Land Use Item Allows the use of multiple categories if available in the specified 
Drainage Library.  To select, utilize the down arrow in the list box and select the desired option.  
The item selected must be associated with a symbology that matches the symbology of each of 
the main land use shapes in the design file.  Our library does not contain multiple categories, 
so this option is not used at MoDOT.  
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Frequency Options 
 
The Frequency Options dialog establishes the computation frequency and runoff peaking factors 
for discharge computations for the current project.   
 

 
 
Drainage Library File (DLB)  The current Library File as specified in the Project Component 
option is displayed.  It cannot be changed from this dialog, only in the Project Components. 
 
Computation Frequency  The displayed frequencies are selected from the available entries in 
the Rainfall Parameters chosen from the library. 
  
Cumulative Frequency  The displayed depths are selected from the available entries in the 
Rainfall Parameters chosen from the library.   
 
Peaking Factors  These factors are used to adjust runoff coefficients for  frequencies other than 
the 5-year or 10-year options.  The frequency correction factor is 1.10 for the 25-year event, 1.20 
for the 50-year event, and 1.25 for the 100-year event. However, the resulting runoff coefficient 
(original "C" multiplied by the frequency correction factor) may not be greater than 1.0  (EPG 
749.5.2.3). 
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Intensity Options    

 
 

Minimum Time of Concentration: 5.0000  
The Minimum Time of Concentration is used for all drainage area computations and pipe travel 
time in discharge computations and is used throughout these computations as the minimum. In 
pipe hydraulic computations this value will be used until the actual time of concentration within 
the systems exceeds this value. Specified in terms of minutes. 
See EPG Section 749.5.3 for Time of Concentration information. 
 
Accumulate Pipe Flow Time by:  Uniform Flow Velocity 
The Accumulate Pipe Flow options adjust the travel time through the pipe. Options include 
Uniform Flow Velocity (uses velocity associated with normal depth to establish travel time), Full 
Flow Velocity (uses velocity associated with full flow [V=Q/A] to establish travel time) , and 
Iterative Velocity (GEOPAK analyzes the network under three iterations, so velocity and travel 
time closely match actual flow conditions). 
 
Intensity Options  Compute Intensity from Library Rainfall Data Source 
The Weight Time of Concentration is used when combining different types and times of 
concentration, activating this toggle weights the times of concentration such that the discharge 
will not decrease.   
 
Inlet Computation Only The Absolute Intensity provides a constant intensity that overrides the 
Drainage Library File and utilizes the specified value for discharge computations required for 
inlet and spread calculations only. Network hydrologic discharges will be computed as specified 
in the Intensity Options. Note, however, for the value to be utilized, the toggle to the left of the 
Absolute Intensity within the Inlet Computation Only box must be activated or the value will 
be ignored. Specified in terms of in/hr or mm/hr depending on the project units. 
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Junction Losses Options 
 AASHTO default coefficients and Method 2 are used to compute junction losses. 
 

 
 
Disable All Junction Loss Computations 
If the toggle is active, no Junction Loss computations are calculated.  
 
Note:  If a single or small number of Junction Losses are not desired, an option is provided later 
in the design to accomplish this. The toggle here applies to the entire project. 
 
Loss Velocity 
Losses can be computed on Actual or Full Flow. 
 
Pressure Expansion 
Loss coefficient to be used in pressure (full flow) expansions within the system. 
 
Free Surface Expansion 
Loss coefficient to be used in free surface (partial flow) expansions within the system. 
 
Pressure Contraction 
Loss coefficient to be used in pressure (full flow) contractions within the system 
 
Free Surface Contraction 
Loss coefficient to be used in free surface (partial flow) contractions within the system. 
 
 
 



Chapter 1 Introduction 

1-16 Missouri Department of Transportation 10/18/12 

Bend Loss 
Specify the methodology and source of bend loss computations.  

• Method 1 utilizes Modern Sewer Design, while Method 2 utilizes AASHTO methods. 
 
Terminal Inlet / Junction 
Loss coefficient to be used at terminal inlets or junctions (no upstream pipes) within the system. 
 
Simple Junction 
Specify the methodology for computing junction losses at simple junction (one pipe into the 
junction and one pipe out).    

• Method 1 utilizes Modern Sewer Design, while Method 2 utilizes AASHTO methods. 
 
Complex Junction 
Specify the methodology for computing junction losses at complex junctions (more than one 
pipe in and only one pipe out).  

• Method 1 utilizes Modern Sewer Design, while Method 2 utilizes AASHTO methods. 
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Inlet Options 
The Inlet Options establish the default inlet variables to use in the Node Configuration Properties 
for each type of inlet. 
 

 
 

Inlet By Pass Options:  By Pass as Total Discharge  
This option indicates the method by which Inlet by pass flows are accounted for in the system. By 
Pass as Total Discharge will account for by pass flows as the difference between the total 
discharge to the inlet and the inlet capacity. This difference, expressed in flow units, will be the total 
by pass from the inlet and can be added at a subsequent downstream inlet. By Pass as C x Area 
Product, on the other hand, is determined from the total bypass at the inlet as a product of runoff 
coefficient and drainage area that is contributing to the total bypass at the inlets computed intensity. 
This product of area and runoff coefficient will then be added to the composite runoff coefficient and 
area at the  downstream inlet. 

 
Link By Pass Flow Options:   Do Not Allow Inlet By Pass in Link Discharges  

This option indicates the method by which Inlet By Pass flows are accounted in the Link discharge 
computations. Do Not Allow Inlet By Pass in Link Discharges will prevent the system from 
bypassing discharges from one inlet to the next when Link discharges are computed. The total 
discharge that reaches the inlet will be considered entering the Link at that point. This option in no 
way impacts the inlet computations, bypass flows will be reflected in these computations. Allow 
Inlet By Pass in Link Discharges will account for the discharge that bypasses the inlets when the 
Link discharges are computed. Only the discharge entering the inlet will be considered entering the 
Link at that location. Bypass flows will be directed to the appropriate inlet and the Link accordingly. 
 

Default Spread N Value:  0.016  
The default Manning's roughness coefficient for the spread hydraulic computations. 
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Node Options 
Select the node-link graphical interface and node naming convention. 
 

 
  
Default Node ID Prefix:  CB – 
 All nodes will be identified as CB-# where # starts at 1and is numerically sequenced by 1 as 
additional nodes are added to the system. (Drainage Areas share the same ID’s as Nodes.)  Feel 
free to change the prefix.  For large projects it may be beneficial to break up the project into 
different series: (A1, A2, …An) , (B1, B2, …Bn), etc. 
 
Scale Node Cells should be toggled off.  We design projects on a one to one scale. If it is on, just 
make sure it is at a Scale Factor of 1.0000 
 
Minimum Freeboard:  1.0000 (see EPG Sec 750.4.4.7)  
This option is used to maintain a certain amount of free space in the node from top of water 
surface to top of inlet.  GEOPAK measures freeboard from the hydraulic grade line to inlet 
elevation. 
Note:  This option does not affect computations in any way.  It is only used to trigger a warning 
(HGL Blowout) if the hydraulic grade line forces less than minimum freeboard. 
 
 
 
 
 
 
 
 



Chapter 1 Introduction 

10/18/12 Missouri Department of Transportation 1-19 

Link Options 
Set the preferred design options for the design of the conveyance system. 
 

 
 

Default Link ID Prefix:  SS – 
All links will be identified as SS-# and start at 1 and numerically sequenced by 1 as additional 
links are added to the system.  Feel free to change the prefix.  
  
Design Optimization considers the pipe profile envelope created when nodes and links are 
placed and a minimum soffit and maximum invert are established. 
Minimize Pipe Size uses the entire envelope to size pipes and will choose smaller pipe sizes 
with steeper slopes if possible.  If the entire envelope does not result in a smaller pipe then the 
appropriate size pipe will be selected based on the top of the envelope. 
Minimize Depth of Cover bases pipe sizing on the top of the envelope maintaining a 
minimum soffit elevation. 
       
Elevation Option is used to establish the elevation that is reported for the ends of each link 
when a profile is generated.  Hydraulic Center reports the elevation at the center of the node 
structure and Actual End reports the elevation at the actual end of each pipe. 
 
Link Design Options:  Design for Full Capacity is the preferred option and uses 100% flow 
to design the pipe size for capacity greater than the discharge. 
Note:  In comparison Design for Maximum Capacity assumes approximately 90% flow. 
 
Hydraulic Gradeline Basis:  Equal Hydraulic Gradeline is preferred and assumes that the 
starting lower end HGL of a link is equal to the upper end HGL of the downstream link. 
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Profile Options 
GEOPAK Drainage allows users to store chains (hydraulic) and profiles (hydraulic) in COGO.   
 

 
 
 
Default Profile ID Prefix:  PR – 
This prefix is added to the beginning of the each defined profile automatically and then 
numerically sequenced by one. For example, the first Profile stored would obtain default ID in 
this case of "PR–1" followed by "PR–2", "PR–3", etc. for subsequent Profiles.  If the links are to 
be used for COGO chains or profiles, the length of this prefix should be within the parameters 
for chain and profile character limitations. 
 
Create COGO Chains and Profiles 
When toggled on, the links are stored in the coordinate geometry database (GPK) specified in the 
Project Components.  The link name is used as both the chain and profile name.  Stationing 
starts at 0+00. 
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Plan Symbology 
The defined symbology is set to reflect the MoDOT CADD Standards.  This symbology may be 
revised or manipulated at any time.  To change the symbology for any item simply double-click 
that item and make the desired revision. 

Updates 
Choose to Automatically update the components in the current drainage file as changes are made 
to the system. 
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Save Options 
Choose whether to Automatically save all drainage updates, save a backup or save at give 
intervals of time   
 

 
 

 
Automatically Save Drainage Updates When activated, the Drainage project file (.gdf) is saved 
every time an Apply command is issued from any Drainage dialog. 
 
Automatic Backup When activated, a backup file is always created (in the project directory 
with a *.bak extension) when the project is opened. 
 
Because of the corruption issues that we deal with from time to time on the GDF files, it is 
recommended that you enable the Automatic Backup option. 
 
Automatic Save To automatically save, activate the toggle to the left of the option, then select 
the desired time interval. 
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Drainage Preferences may be changed at any time and the system can then be redesigned or 
analyzed utilizing the new settings. 
 
There are times when you might want to set up different scenarios using different preference 
settings to see how a drainage system will act under different conditions.  Preferences can be 
saved by going to the File pull-down menu on the Preferences dialog box and choosing the Save 
As option and saving the current preference settings as a new DPF (Drainage Preference File).  
These preferences can then be recalled anytime they’re needed by using the Open option under 
the File pull-down menu. 
 

 
 

 
 
 
 

2. Click the OK button on the Preferences dialog box to enable the current 
settings and close the dialog. 
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1.7 Review Drainage Library 
 
The Drainage Library is used to store data and standards that may be shared by different projects 
and designers.  MoDOT supports one main library (dote.dlb).   A metric library is also 
available as well as custom libraries if needed.  These libraries are maintained at CADD Support, 
and should not be modified. 
  
 

1. Click the Project drop-down menu and select Drainage Library. 
  
 

 
 
When the Drainage Library dialog comes up, make sure the banner displays the path as 
T:\Gpk_Std\Drainage\dote.dlb 
  
Note the first four tabs in the Drainage Library: 
  

• Rainfall: Contains the Rainfall Data Sources 
• Land Uses: Contains the specific Land Uses and their corresponding “C” value 
• Nodes:  Inlets, Junctions, Manholes, Outlets, etc. 
• Links:  Circular Pipes, Elliptical Pipes, Pipe-Arch pipes, Boxes, etc. 
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Rainfall Tab 
 
Rainfall Items store all the rainfall data information to be used on GEOPAK Drainage Projects.  
GEOPAK Drainage supports rainfall sources in the form of intensity duration frequency (IDF) 
tables, or as coefficients for intensity-duration-equation formats.  Also supported are the SCS, 
HYDRO-35 and TP 40 methods of rainfall. 
 
This is the same information used to develop our IDF curves for each District.  See the EPG 
749.5.4. 
 

   
 

  

 

Modify 

To explore the data highlight any rainfall item, then right-click and select Modify.  Or select 
the modify button on the right.  Take a look at the defined information. 
When you are finished reviewing the information select the Cancel button to exit the 
Rainfall Data Source Item dialog. 
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Land Use Tab 
 
Land Uses are used to store runoff coefficients ("C" values) and corresponding symbology for 
each land use.  The runoff coefficients are divided up into two groups: Rural and Urban.  The  
rural coefficients are based on the topology and soil classification while the urban coefficients 
are defined based on the land use.  See the EPG 749.5.2. 
 
 Land Uses can be automatically delineated with GEOPAK Drainage.  The DGN file is scanned 
for the land use symbology from the Drainage Library and associates the symbology, as well as 
the graphical shape, with the "C" value as set in the library. The “C” values are then weighted 
according to their ratio of land area within the main area delineation, and a properly weighted 
“C” value is calculated for the land area under consideration.  Alternately, the land uses can be 
put into the project manually. 
 

.   
 

           

 

To explore, highlight the MoDOT item, right-click and choose Modify 
When done select Cancel. 
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Nodes Tab 
 
Nodes contain standard configurations for Grates, Curbs and Slotted Drain inlets, as well as 
Junctions, Outlets and Other Nodes.  The description, plan view representation and dimensional 
information for each Node item is entered only once in the Drainage Library and then referenced 
by each project. 
 

 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Choose the Grate option from Node Types, then select the first node and Modify. 
You can review the cell information by pressing the Select button to the right of the Plan 
View Cell field.   
When complete, close both the cell selector and the node item by choosing Cancel.  
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Links Tab 
 
The Links are categorized by three properties for each pipe: Shape, Material, and Type 
(corrugation).  Each pipe resides in its own dialog box that contains the specific pipe geometry, 
default roughness coefficient and material combination. 
 

 
                   

 
 
 
 
 

 
 
 

To explore the type of data common to the links, set the Shape to Circular, the Material to 
Concrete.  Highlight the first pipe, then choose Modify.  
When done select Cancel.  
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Spread Section Tab 
 
The Spread Section tab is used to set up roadway section spread situations.  MoDOT has not 
developed library items for this option.   
 
More information will be given when setting Spread Criteria in the Node Configuration (Inlets) 
section of the class. 

 
 
 
 
 

2. Exit out of the Drainage Library. 
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